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1.Introduction

This application note is a step-by-step guide you to
build a multicore IPC (Inter-Processor Communication)
application on NXP S32G2 processor using the NXP
software Bundle-2022.07. You can follow this guide as
an example to enable all application cores of S32G274A
processor.

The guide does not target optimization of the booting
time. The SD-Card is used for booting and root file
system media for Linux OS running on ARM® Cortex-
A53® cores.

The secure boot in example only supports verification of
the bootloader image using HSE SMR (Secure Memory
Region) service. The bootloader is not configured to
perform verifications on subsequent images.

The following sections are covered in the document.
e Multicore IPC application description
e Hardware and software prerequisites
e Prepare images for Cortex-A53 cores
e Prepare images for Cortex-M7® cores
e Configure and build the bootloader
e Deployment on S32G2-VNP-RDB2
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Multicore IPC application description
e Run the applications on S32G2-VNP-RDB2

2. Multicore IPC application description

After booting up, the bootloader loads the IPC application for each Cortex-M7 core. It also gets
application to run a sample application on Linux to send “Hello world!” messages to Cortex-M7 cores
via IPC channel. On receiving the message, the IPC application on Cortex-M7 core responds with an
echo message.

Hello world!

Bootloader

Figure 1. Sample application

2.1. S32G2 Boot flow

The secure boot is enabled in the default configuration of the Bootloader. For the First time boot after
image deployment on RDB2, the secure boot is not enabled, it means, the BOOT_SEQ in the IVT is set
to zero. When the bootloader runs for the first time, it detect this condition and configures the HSE for
secure boot and then set BOOT_SEQ=1. After setting BOOT_SEQ=1, the bootloader issues a functional
reset. For every following boot, secure boot is enabled.

You can disable the secure boot in the EB Tresos configuration. For detail, please refer to the section
“7.2.2 Secure boot configuration’ of the Bootloader User Manual.

The following figures show S32G2 boot flow examples for both non-secure and secure boot.
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Figure 2. Non-secure boot flow
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Figure 3. Secure boot flow

NOTE

For definition of BL2/BL31/BL33, refer to the section “25 ARM Trusted
Firmware” in the “Linux BSP 33.0 User Manual for S32G2 platforms”.
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3. Hardware and software prerequisites

The following table shows the hardware and software prerequisites.

Table 1. Harware and software prequisites

Iltem

S32G-VNP-RDB2

S32 Design Studio 3.4
with the update 3
(3.4.3_D2112)

EB Tresos Studio 27.1

S32G2 Standard &
Reference Software

Cygwin

Putty

Description

Hardware board with the
processor S32G274A

IDE with S32 Configuration Tool
and S32 Flash Tool.

AUTOSAR configuration tool.

NXP released software. Below
items are required:

S32G2 Platform Software
Integration 2022.06

HSE Standard Firmware 0.1.0.5
Inter-Platform Communication
Framework 4.6.0

Linux BSP 33.0.0

Real-Time Drivers 3.0.2 HFO1
FreeRTOS 3.0.2

SDHC Stack 1.0.1 HF1

A large collection of GNU and
Open Source tools which provide
functionality similar to a Linux
distribution on Windows.

Serial terminal

Note

It is required to modify AUTOSAR
configuration of the bootloader.

Please download each software in your NXP
software account or use the Automotive
Software Package Manager.

It is used to run the make tool and to deploy
images on SD-Card.

4.Prepare images for Cortex-A53 cores

Follow the user guide of Linux BSP 33 to build the u-boot and ATF
1. Download the GCC 10.2.0 toolchain for ARM 64-bit (download link).
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https://www.nxp.com/app-autopackagemgr/software-package-manager:AUTO-SW-PACKAGE-MANAGER
https://www.nxp.com/app-autopackagemgr/software-package-manager:AUTO-SW-PACKAGE-MANAGER
https://developer.arm.com/-/media/Files/downloads/gnu-a/10.2-2020.11/binrel/gcc-arm-10.2-2020.11-x86_64-aarch64-none-linux-gnu.tar.xz?revision=972019b5-912f-4ae6-864a-f61f570e2e7e&la=en&hash=B8618949E6095C87E4C9FFA1648CAA67D4997D88

2.

Prepare images for Cortex-A53 cores

Once you have downloaded the toolchain package, in order to install it, you just need to unzip it
in a directory of your choice.

$tar -xf gcc-arm-10.2-2020.11-x86_64-aarch64-none-linux-gnu.tar.xz

Clone the GIT repository

$export HOME=/path/to/your/workspace

$cd $SHOME

$git clone https://source.codeaurora.org/external/autobsps32/u-boot
$cd u-boot

$git checkout release/bsp33.0-2020.04

Build the U-Boot bootloader

$export CROSS_COMPILE=$HOME/gcc-arm-10.2-2020.11-x86_64-aarch64-none-linux-
gnu/bin/aarch64-none-linux-gnu-

$make s32g274ardb2_defconfig

$make

To build the Arm-trusted-firmware the steps needs to be followed:

1.
2.

Install libssl-dev and openssl for headers required by fiptool. This is a one-time operation.
$sudo apt-get install libssl-dev openssl

Check your host dtc version.

$dtc --version

If your dtc is older or you do not have it installed, install/upgrade to dtc version 1.4.6 or above:
$sudo apt-get install device-tree-compiler

Clone the GIT repository

$cd $SHOME

$git clone https://source.codeaurora.org/external/autobsps32/arm-trusted-firmware

$cd arm-trusted-firmware

$git checkout release/bsp33.0-2.5

Apply the patch to modify the alignment of ATF. Please find the patch in accompanying
software package of this application note.

The bootloader expects a 64-bytes-aligned image. Thus, the ATF makefile arm-trusted-
firmware/plat/nxp/s32/s32_common.mk needs the parameter "FIP_ALIGN := 16" change it to
"FIP_ALIGN := 64" before you start the build.

$git am < /path/to/0001-fip-align-and-mmc-init.patch

Build the ATF
$make ARCH=aarch64 PLAT=s32g274ardb2 BL33=$HOME/u-boot/u-boot-nodtb.bin

After build is complete, the generated images are in the directory: arm-trusted-
firmware/build/s32g274ardb2/release. The log shows load address and entry point of the
generated FIP image, like below:

IVT Location: SD/eMMC

Load address: 0x342fc580
Entry point:  0x34302000

The following steps shows how to build an IPC multiple instance example on Linux:

1.

Build the kernel using the following command
$cd SHOME

Enabling Multicore Application on S32G2 using S32G2 Platform Software Integration, Rev. 0, 11/2022



https://source.codeaurora.org/external/autobsps32/u-boot
https://source.codeaurora.org/external/autobsps32/arm-trusted-firmware

Prepare images for Cortex-A53 cores

$git clone https://source.codeaurora.org/external/autobsps32/linux
$cd linux

$git checkout release/bsp33.0-5.10.109-rt

$make ARCH=arm64 s32genl_defconfig

$make ARCH=arm64

The command generates the kernel binary (Image) in arch/arm64/boot and the board device tree
blobs in arch/arm64/boot/dts/freescale.

2. Build the IPCF modules.

$cd $SHOME

$git clone https://source.codeaurora.org/external/autobsps32/ipcf/ipc-shm
$cd ipc-shm

$git checkout release/SW32G_IPCF_4.6.0_D2205

Apply the patch to enable three IPC instances. Please find the patch in accompanying software
package of this application note.

$git am < /path/to/0001-ipc-multi-instances.patch

Build IPCF driver and sample modules providing kernel source location

$cd $SHOME
$make -C ./ipc-shm/sample_multi_instance KERNELDIR=$PWD/linux modules

To deploy the built image to a SD card the steps needs to be followed:
1. Download the pre-built images of Linux BSP 32 from nxp.com:
binaries_auto_linux_hsp33.0_s3292 pfe.tgz
Extract the package to your local folder.
Deploy images on SD-Card (On Windows)
e Insert the SD-Card to your PC

e Launch the Cygwin (run as administrator) and run the following commands to write bsp
image to SD-Card

NOTE
/dev/sdb is the device node for the SD-Card.

$cd binaries_auto_linux_bsp33.0_s32g2_pfe/s32g274ardb2/

$dd if=/dev/zero of=/dev/sdb bs=512 count=1 && sync

$dd if=fsl-image-auto-s32g274ardb2.sdcard of=/dev/sdb bs=1M skip=4 seek=4
$dd if=fsl-image-auto-s32g274ardb2.sdcard of=/dev/sdb bs=1M count=4 && sync

e Copy the fip.bin and fip.s32 from the directory “arm-trusted-
firmware/build/s32g274ardb2/release” to the current folder. Use the newly built FIP
image to replace the one from pre-built images:

$dd if=fip.s32 of=/dev/sdb skip=512 seek=512 iflag=skip_bytes oflag=seek bytes
conv=fsync,notrunc

NOTE
fip.bin will be deployed on Nor-Flash.

e Copy the below images to FAT32 partition (boot_s32927) of SD-Card

Enabling Multicore Application on S32G2 using S32G2 Platform Software Integration, Rev. 0, 11/2022
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= Copy the kernel image (linux/arch/arm64/boot/Image) and replace the one on SD-
Card.

= Copy the dtb image (linux/arch/arm64/boot/dts/freescale/s32g274a-rdb2.dtb) and
replace the one on SD-Card.

= Copy the ipc image (ipc-shm/ipc-shm-dev.ko, ipc-
shm/sample_multi_instance/ipc-shm-sample_multi-instance.ko).

5.Prepare images for Cortex-M7 cores

5.1. Building ipc application using S32DS

To install the S32 Design studio, follow these steps:
1. Download the S32 Design Studio 3.4 and complete installation

e Download the installer file: S32DS.3.4_b201217 win32.x86_64.exe, finish installation
following the S32DS Installation Guide.

e Download the offline package includes Update 3 for S32 Design Studio v.3.4 and S32G
development package: SW32G_S32DS _3.4.3 D2112.zip. Follow the release note to install
it.

Follow the steps to install RTD and IPCF package for S32DS:
1. Download the RTD release: SW32G_RTD_4.4 3.0.2_HF01_DS updatesite_D2204.zip.

2. Launch the S32DS. Go to Help > "Install New Software...". In the Install window, click ‘Add..."
> "Archive..." to open the SW32G RTD 4.4 3.0.2 HF01 DS updatesite D2204.zip. Click
Add to close the window.

In the Install window, select all items, click "Next >" to finish installation.

4. Download the below IPCF, FreeRTOS and SDHC release. Follow similar steps to finish
installation

e SW32G_IPCF_4.6.0_D2205 updatesite.zip
e SW32 FreeRTOS 10 4 6 UOS 3 0 2 DS _updatesite D2204.zip
e S32G_SDHC _RTM_1 0_1 HF1 D2207_updatesite.zip
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Follow the steps to build ipc application using S32DS:

1. Find the example used as an accompanying software package of this application note. Extract the
package to your local folder.

2. Launch the S32 Design Studio.

3. Import the three projects into S32DS:
e |PCF_Example_multi_instance_S32G274_M7_0,
e |PCF_Example_multi_instance_S32G274 M7 _1,
e |PCF_Example_multi_instance_S32G274_M7_2.

4. For each project, double click the mex file, open the S32 Configuration Tool. Then click the
“Update Code" button to generate the source code.

5. Build projects to get elf and binary image. The outputs are in the Debug_RAM folder.

5.2. Configure the bootloader

Follow the steps to install RTD and Platform Software Integration package for EB tresos:
1. Download and install the RTD software

e Download the installer 'SW32G_RTD 4.4 3.0.2_ HF01 D2204.exe’, double-click to
install it.

e After installation, you will get the folder 'SW32G_RTD_4.4_3.0.2_HFO01" at your
installation directory.

e Copy all plugins of RTD to the EB directory: copy all items at the directory
"SW32G_RTD_4.4 3.0.2_HFO01\eclipse\plugins to "C:\EB\tresos\plugins

2. Download and install the platform software integration software
"Platform_Software_Integration_S32G2_2022_06.exe’

Enabling Multicore Application on S32G2 using S32G2 Platform Software Integration, Rev. 0, 11/2022
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e Download the installer "Platform_Software_Integration_S32G2_2022_06.exe", double-
click to install it. In this example, we install it to the default directory:
C:\NXP\Integration_Reference_Examples_S32G2_2022_06.

Follow the steps to import the bootloader project:
1. Launch the EB tresos 27.1.0

2. Follow the menu File > Import to open the Import window. Select General > "Existing Projects

into Workspace', then click Next.

3. Click "Browse..." and in the "Brower For Folder” window navigate to the installation directory
of “Integration_Reference_Examples S32G2_2022_06". Then click Ok.

4. 1t will show all projects in the selected directory. Uncheck the lighting projects. In the Options
section, select "Copy projects into workspace’, then click Finish.

B Import
Import Projects

Select a directory to search for existing Eclipse projects.

@® Select root directory: | C\NXP\Integration_Reference_Examples_S32G2_202: v‘

O Select archive file:

Projects:

Bootloader S32G2X3{ ASR 4.4 M7 (C\NXP\Integration_Reference_Exampl
[ Lighting_MultiCore_S32G2XX_ASR_4.4_M7 (CA\NXP\Integration_Reference_
[ Lighting_SingleCore_S32G2XX_ASR_4.4_M7 (C\NXP\Integration_Reference

< >

Options

[[1Search for nested projects

Copy projects into workspace

[IHide projects that already exist in the workspace

Working sets

[ Add project to working sets

=

Browse...

Select All
Deselect All

Refresh

Cancel

-

Figure 4. Project import

Follow the steps to Configure the bootloader:

1. Inthe "Project Explorer” view, right click the Ecuc item, and select the menu "Load

Configuration’.
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B8 EB tresos 27.1.0 - waorkspace: C\EB\tresos\workspace - install: C\EB\tresos
File Edit Search Project Window Help

el H R T R I R A PR R A R SIS

[ty Project Explorer 2 & Y= 0

~ LB Bootloader_S32G2XX_ASR_4.4_M7
&? EcuC (CORTEXM, S32G2XXM ™
» = config
> = output

Load Cenfiguration
Reload Configuration

Im- and Exporters...
Module Configurations...

Verify Project
Generate Project
“=  Build Project

Expand All

2. In order to make it simple, we will disable the XRDC in this example. Follow below steps to
disable XRDC

e Right click the Rm plugin and select the menu Disable to disable the RM plugin

[z *Project Explorer 2 BEg =0
v 8 Bootloader_S32G2XX_ASR 4.4 M7
v @ EcuC (CORTEXM, S32G2XXM7)
> @ Base (302, AS4.4.0)
> @ Bootloader (V226.0, AS44.0)
> @ Can (V302 AS44.0)
> @ Canlf (V302, AS4.40)
> @ ComDal (V22.6.0, AS4.4.0)
> @ ComManager (V22.60, AS4.4.0)
> @ Crypto (V302 AS44.0)
» @ CryptoDal (V22.6.0, AS44.0)
> @ EuC (V3.02, AS4.4.0)
> @ EcuM (V3.0.2, AS44.0)
> @ Eep (V302 AS44.0)
> @ Fls (V3.0.2, AS440)
> @ Gpt (V3.0.2, AS44.0)
> @ Mcl (V302, AS4.40)
> @ Meu (V3.0.2, AS44.0)
> @ MemDal (V226.0, AS44.0)
> @ Os (V30.2, AS440)
> @ Port (V3.02, AS440)
> @ Resource (V3.0.2, AS44.0)
> ®Rm (V302 AS44C [
> @ SysDal (V226.0, AS| pieaple
> & config

> & output Verify Configuration

Generate Configuration
Build Configuration >

N

Expand All

e Navigate to the SysDal plugin configuration, select SysDalBswConfig > PowerUp >
DeinitList. In the list, remove the item Rm_Init.
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@) *SysDal (SysDal)

SystemPowerUpConfig

Name @‘SystemPuwerUpConﬁg,O

InitList DeinitList

B DeinitList

Index & Name Parame... Callout ...
0 = MembDal_Delnit 'y MemDal.h
1 (= SysDal_Rtm_Delnit o SysDal_R...
2 = Mcl_Delnit B Mcl.h
3 = Mcu_nitClock McuCloc... Mcu.h
4 = Qspi_lp_ControllerDeinit 0 Qspi_lph
5 (= Gpt_Delnit B Gpth

""" 6 = Rmnit D Rm

............................................ % Move element up B |

=¢ Add element
# Remove element
=| Duplicate element

E4 Bulk Change...
# Editelement..

Navigate to the configuration of Bootloader plugin. Select the "Core Configuration™ and it lists
all boot targets and boot sources that will be loaded by the bootloader. This example uses the
bootloader to bring up Linux BSP on A53 cores and IPC example on each M7 core. So, you need
to configure the four elements in this list:

e 1x for Cortex-A53 cores: Uses the images from Linux BSP 33

e 3x for the three Cortex-M7 cores: Use the images of IPC application built by the S32
Design Studio

These list will be edited later.

® Bootloader (Bootloader) 2

Bootloader

Name @& ‘Eootloader

General Core Configuration . Boot Sources| Boot Triggers

E Core Configuration

Imi\ex (= Name CorelD @ Boot source configuration [¥ Is a critical application [¥  Start the core
0 &= A53_0_BSP_ATF A53.0 @ /Bootloader/Bootloader/BootSources_AS3_BSP_ATF [ &1 £'Y%
1 & M7_0_Platformintegration M7_0 @ /Bootloader/Bootloader/BootSources M7_LightingApp |1y & I

Navigate to the Bootloader plugin configuration. Select the ‘Boot Source’ configuration.
Remove all elements in the boot source list.
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©) SysDal (SysDal) €| Bootloader (Bootloader) 2

Bootloader

Name = ‘Bootloadel

General | Core Configuration | Boot Sources . Boot Triggers

B Boot Sources

IndAex = Name Boot source Boot image authen.. [& Reset handler address

{0 (= BootSources AS3 uboot o QSPI » NONE B NC P
1 = BootSources M7 _LightingApp aspl NONE 2 ke
2 (= BootSources_AS3_BSP_ATF Qspl NONE E Add element

&=

# Remove element
=| Duplicate element

Set default value

Bulk Change...

R Ba

Edit element.

Disable autodisplay
7 Autodisplay as HEX
m  Autodisplay as BIN
= Autodisplay as DEC
=i Autodisplay as OCT

Show Separators

5. Add Boot source for the ATF FIP image

e Click the button “add new element with default values’, and edit it as below:

=] 'Boot Sources

Inc?ex = Mame Boot source Boot image authen... |z Reset handler address
0 = linux_bsp_atf p QSPI b NONE e 0x34302000

e Navigate to "Boot Sources™ > "linux_bsp_atf* > "Boot image fragments™ and configure
the "Boot image fragments™ of the "linux_bsp_atf" as below:

E Boot image fragments

Inc/!\ex = MName [& Source address (in.. @ M. @ C. [@ Loadimageataddr. [& Imagesize(b.. [& Image CRCvalue
0 = ImagefFragments 0 = 0x100000 (@ @) = 0x342fc580 = 262144 |7 0x0
NOTE

e The "Reset handler address™ and "Load image address™ are from the log
of building the ATF. The example:

IVT Location: SD/eMMC
Load address: 0x342fc580
Entry point:  0x34302000

e The image size was set to 256KB. It should be larger than the size of
BL2. Find the value from the log of building ATF. The example:

Image Layout
DCD: Offset: 0x200 Size: Ox1c
IVT: Offset: 0x1000 Size: 0x100
AppBootCode Header: Offset: 0x1200 Size: 0x40
Application: Offset: 0x1240 Size: 0x2ec00
6. Add a Boot source for IPC application on Cortex-M7_0 core

Enabling Multicore Application on S32G2 using S32G2 Platform Software Integration, Rev. 0, 11/2022
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e Click the button “add new element with default values’, and edit as shown below:

= Boot Sources

|# Reset handler address
0x34302000
0x34380010

Boot image authen...
» NONE E
» NONE &

Boot source
p Q5P
» QSPI

Inc?ex = MName
0 & linux_bsp_atf

1 & ipc_app_m7_0

e Navigate to "Boot Sources™ > “ipc_app_m7_0" > "Boot image fragments™ and
configure the "Boot image fragments™ of the “ipc_app_m7_0" as shown below:

B Boot image fragments*

Inc/i\ex = MName [# Source address (in.. @ M. @ C. [ Loadimageataddr.. [ Imagesize(b.. [E Image CRC value

0 (= ImageFragments 0 |& 0x200000 &g @) = 0x34380000 | 1048576 | D)(D

NOTE

The M7_0 core is the core running the bootloader. It will jump to the
application by setting the PC to the reset exception handler address.

The "Reset handler address™ and "Load image address™ are indicated in the
map file:

- Search the key word Reset_Handler in the map file to get the value
of "Reset handler address’,

- Search the key word int_sram_cO0 in the map file to get the value of
"Load image address'.

7. Add a Boot source for IPC application on Cortex-M7_1 core.

Click the button “add new element with default values’, and edit as shown
in the figure below.

= Boot Sources*

Inc/!\ex = MName Boot source Boot image authen... & Reset handler address
0 (= linux_bsp_atf o QSPI o NONE = 0x%34302000
1 = ipc_app_mi_0 p QSPI o NONE = 0x%34380010
2 = ipc_app_m7_1 o QSPI s NONE E 0x34501000 |

Navigate to "Boot_Sources™ > “ipc_app_m7_1" > "Boot image fragments’
and configure the "Boot image fragments™ of the “ipc_app_m7_1" as
below:

= Boot image fragments*

Inc/i\ex = MName [ Source address (in.. @ M. @ C. [ Loadimageataddr. [& Imagesize(b.. [E Image CRCvalue

0 = Imagefragments 0 | 0x300000 @g @) |re 0x34480000 |z 1048576 | D)(l)

NOTE
The "Reset handler address™ and "Load image address™ are indicated in the
map file:
e Search the key word intc_vector in the map file to get the value of
"Reset handler address'.

e Search the key word int_sram_c1 in the map file to get the value of
“Load image address’.
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8. Add a Boot source for IPC application on Cortex-M7_2 core.

e Click the button “add new element with default values, and edit as shown
in the figure below:

E Boot Sources

In&\e)( = Name = Boot source =/ Boot image authen... & Reset handler address
0 = linux_bsp_atf I QsPI 5 NONE & 0%34302000
1 = ipc_app_m7_0 I QSPI 5 NONE = 0x34380010
2 = ipc_app_m7_1 I Q5PI 5 NONE & 0x34501000
3 = ipc_app_m7_2 p Q5PI o NONE = 0x%34601000 |

Navigate to "Boot Sources™ > “ipc_app_m7_2" > "Boot image fragments™ and
configurethe "Boot image fragments™ of the “ipc_app_m7_2" as below:

E Bootimage fragments

Inaex = Name [ Source address (in.. @ M. @ C. [@ Loadimage ataddr.. [@ Imagesize (b.. [E Image CRCvalue
0 = ImageFragments 0 |- 0x400000 @ @ E 0x34580000 || 1048576 | 0x0
NOTE
The "Reset handler address™ and “Load image address’ are indicated in the
map file:

- Search the key word intc_vector in the map file to get the value of "Reset
handler address’,

- Search the key word int_sram_c2 in the map file to get the value of
“Load image address'.

9. Navigate to Bootloader > "Core Configuration’, clear the core configuration list.

10. Add elements for each core with below configuration to the list as shown in the
figure below.

B Core Configuration

Index & Name |5 CorelD @ Bootsource configuration [¥ Is a critical application [¥] Start the core
0 (= AS3_ATF = AS3.0 @] /Bootloader/Bootloader/linux_bsp_atf g v lp
1 = M7_0IPC | M7_0 @] /Bootloader/Bootloader/ipc_app_m7_0 g v 1] ]
2 = M7_1IPC » M7_1 @ /Bootloader/Bootloader/ipc_app_m7_1 g v g v

i 3 (= M7 2IPC =l M7 2 @ /Bootloader/Bootloader/ipc_app_m7_2 g v/ Dg v

11. Right click the EcuC and select "Generate Project’. After successfully generated,

click OK to finish it.
v (B Bootloader_S32G2XX_ASR_4.4 M7

Bootloader

v @ EcuC (CORTEXM, 3P~ eam : ;

@ Base (V3.02, AS4 Load Configuration

& Bootloa&elr J{V22 Reload Configuration

@ Can (V3.0.2, AS4.4 Im- and Exporters...

@ Canlf (V3.0.2, AS4 Module Configurations...

@ CombDal (V22.6.0, Verify Project

& ComManager (Vz Generate Project

@ Crypto (V3.02, AS % Build Project 5
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8 Code Generator Run Finished *

.:6:, (13026) Code generation finished successfully. Errors "0" Warnings "0" reported, for details
= please refer to the Error Log

[ Do not show this dialog again.

5.3.Build The Bootloader

Before compile the code, implement the below change to the file
C:\NXP\Integration_Reference_Examples_S32G2_2022_06\code\framework\realtime\swc\bootloader\g

eneric\src\ Bootloader.c:
#if (STD_ON == BL_CRYPTO_USED)

#include "CryptoDal.h"

+ #include "Hse_Ip.h"

- static volatile uint32 ENABLE_BREAKPOINT_AT_MAIN = 0U;
+ static volatile uint32 ENABLE_BREAKPOINT_AT_MAIN = 1U;
int main(void)

{

#if (BL_USE_BREAKPOINT == STD_ON)

while (OU == ENABLE_BREAKPOINT_AT_MAIN) continue;
#endif /* BL_USE_BREAKPOINT == STD_ON */

+  while (1) {

+ if ((Hse_lp_GetHseStatus(0) & (HSE_STATUS_INIT_OK | HSE_STATUS_RNG_INIT_OK)) ==
+ (HSE_STATUS_INIT_OK | HSE_STATUS_RNG_INIT_OK))

+ break;

+ 1}

NOTE
The above code is in the patch format:

e '+ means inserting the line while “-* means deleting the line.

e The above changes disable the breakpoint by
ENABLE_BREAKPOINT_AT_MAIN. Add the code to wait for
completion of HSE firmware initialization, which avoids the
conflict with HSE when initializing QuadSPl.

1. Navigate to installation directory
“Integration_Reference_Examples_S32G2_2022 06':
C:\NXP\Integration_Reference_Examples_S32G2_2022_06\code\framework\real
time\swc\bootloader\platforms\S32G2XX\build

2. Edit the file launch.bat to set build parameters, below is an example:
SET TRESOS_DIR=C:/EB/tresos
SET MAKE_DIR=C:/cygwin64
SET GCC_DIR=C:/NXP/S32DS.3.4/S32DS/build_tools/gcc_v9.2
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5.4.

SET TOOLCHAIN=gcc
SET CORE=m7
SET SRC_PATH_DRIVERS=

SET SDHC_STACK_PATH= C:/NXP/S32DS.3.4/S32DS/software/PlatformSDK_S32XX_2022_03/stacks/sdhc
SET TRESOS_WORKSPACE_DIR=C:/EB/tresos/workspace/Bootloader S32G2XX_ASR_4.4 M7/output
SET HSE_FIRMWARE_DIR=C:/NXP/HSE_FW _S32G2 0 1 0 5

Launch cmd.exe, execute the launch.bat. After it finishes, find the output in the folder:

build/bin_bootloader

$cd
C:\NXP\Integration_Reference_Examples_S32G2_2022_06\code\framework\realtime\swc\bootloader\platforms\S32
G2XX\build

$launch.bat

Generate S32G Boot Image Using S32DS IVT_TOOL

Open S32 Design Studio and click New -> S32DS Application Project.

In the dialog, select 'S32G274A Rev 2 Cortex-M7" (on the left-hand side), and on
the right-hand side, select the Cortex-M7_0 boot target.

Click Next, uncheck Cortex-M7_1 and Cortex-M7_2, then click Finish.

532DS Application Project (] x

Create a §32 Design Studio Project
New 532DS Application Project

Project name:

532G2_IVT

Use default location

C\02_code\workspace 532ds3.4 Browse...
Processors: ToolChain Selection:
type filter text Core Kind Name Toolchain
B S3262 Cortex-A53 Linux o M7 Cortex-M7_0 NXP GCC 9.2 for Arm 32-bit Bare-Meta v
B S32G233A Cortex-M7 M7 Cortex-M7_1 NXP GCC 9.2 for Arm 32-bit Bare-Meta v
B 532G233A Cortex-AS53 (decoupled m M7 Cortex-M7_2 NXP GCC 9.2 for Arm 32-bit Bare-Meta v

B S32G233A Cortex-A53 (lockstep moc
 S32G234M Cortex-M7
B 532G254A Cortex-M7

B S32G254A Cortex-A53 (decoupled m < >
B S32G254A Cortex-A53 (lockstep moc Description:
B 532G274A Rev1 Cortex-M7 GNU 9.2 Toolchain is selected

i S32G274A_Rev2 Cortex-M7
B S32G274A_Rev1 Cortex-A53 (decoup
B S32G274A_Rev2 Cortex-A53 (decoup
H S32G274A _Revi1 Cortex-A53 (lockste|
B S32G274A_Rev2 Cortex-A53 (lockste|
(= Family 532G3 )
< >

) . -

4. Click the button "S32 Configuration Tools™ and select ‘Open IVT".
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MEC AN MG ASE
Open Pins

Open Clocks

Open Peripherals

Open DCD

Open INT

Open Quad5SPl
Open DDR

Manage SDK Components

s <~c® @

5. Inthe Window "Create a new configuration’, select the processor
S32G274A_Rev2.

6. Select SDK version and Core as below, then click Finish.

ﬁ Create a new configuration m} X

Create a new configuration

Tip: To apply existing board configuration, import it using the command File > Import

Select Processor/Board/Kit

type filter text

Select Processor/Board/Kit Pins Clocks Peripherals DCD IVT QuadSPI DDR Status
~ Processors
v 532G2
532G233A 4 V4 v v v v ~  Cached
532G234M g s v v v v > Cached
S32G254A g g vy v v v ~  Cached
S32G274A 4 Ve v v v v ~  Cached
S32G274A_Rev2 v v v v 7 v +  Cached
> 532G3
> 532R4
MName your configuration
532G274A_Rev2
Select processor package Select core Select SDK version
532G274A_Rev2_525bga - MAPBGA 52 v !Cortex—M? (Core #0) v | | PlatformSDK_S32XX_2022_03 v

®

7. Inthe IVT view, set ‘Boot Target’ to M7_0.

Boot Configuration

Boot Target | M7_0 -

BOOTSEC: Secured boot mode

Boot Target Watchdog

8. Boot device type select "QSPI Serial Flash’, and the QuadSPI1 parameters set to
the file:
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Integration_Reference_Examples_S32G2_2022_06\code\framework\realtime\swc\bootloader\platforms\S32G2XX\res\fl
ash\S32G274_QuadSPI_133MHz_DDR_configuration.bin

Interface selection

Boot device type | QuadSP| Senal Flash - Q

| Configure Quad5PIl parameters

Quad5Pl parameters | CANXP\Integration_Reference_Examples_S32G2_2022_ ‘E &

9. Configure the DCD image. This is used to initialize SRAM on boot stage. The
image file is at:

Integration_Reference_Examples_S32G2_2022_06\code\framework\realtime\swc\bootloader\platforms\S32G2XX\res\fl
ash\S32G274_DCD_InitSRAM.bin

® On (]
DCD

CANXP\Integration_Reference_Examples_S32G2_2022_06\code\framework\realtime\swc\bootloader\ [ ] B ||

Start address | 0x110 ln| Size in bytes

10. Configure the HSE images. Select the HSE firmware image, see the figure for the
example.

For "HSE firmware configuration’, set the "SYS-IMG pointer" to the address
0xCO0000, then lock the address by clicking the lock.

® On [x)
HSE

Start address | 0x120 I Sizein bytes | 332128

¥ HSE FW Configuration

HSE FW Configuration

SYS-IMG pointer

() Reserved

SYS-IMG External Flash Type

QsPl

SYS-IMG Flash Page Size

Size| 0x1000

Application BSB External Flash Type

QsPl

11. Configure the application bootloader image. Select the binary file Bootloader.bin
in the folder: build\bin_bootloader.
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The RAM start pointer and RAM entry pointer set to 0x34700000.

Set "Automatic Align Start Address™ to 0x100 and click Align. If the start address
of item is not aligned as expected, please manually adjust for that.

Automatic Align

Automatic Align Start Address: | (w100 Align

In the “application bootloader’, click "Export Image™ and save it to local folder. In
the example, we use bt_m7_app.bin as the file name.

® On

Application bootloader

CANXP\Integration_Reference_Examples_532G2_2022_06\code\framework\realtime\swc\bootloader [ CHILY;

Start address | 0x130 | Sizein bytes | 268224

¥ Application Boot Code Image

¥ Application Boot Image

RAM start pointer

Address  0x34700000

RAM entry pointer

Address  0x34700000

Code length | 268224

» Serial Boot

Export Image

12. Uncheck other images that are not used.
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13.

‘ a 0 Wi 356

p——.

A bt W41 e

uuuuuuuuuuu

Click "Export Blob Image™ and save the boot image to local folder. In the
example, we use bt_m7_blob.bin as the file name.

6. Deployment on s32g-vnp-rdb2

The following are the steps to program the Nor-flash using the S32 flash tool.

1.

N o gk~ D

2

10.
11.

12.

Launch S32 Flash tool at the directory:
C:\NXP\S32DS.3.4\S32DS\tools\S32FlashTool\GUI\s32ft.exe

Set the Target and Algorithm as the figure.

Connect RDB2 UARTO to your PC USB port

Set the COM port name, for example, COM4

Set the RDB2 to Serial boot mode: SW10-1=0OFF,SW10-2=0OFF
Power on the RDB2.

Click “Upload target and algorithm to hardware...", then the tool will start to load the algorithm
image and configure the target.

Click "Erase memory range...” and erase the memory range 0x0 - 0x500000.
Click "Upload file to device...” and select the bt_m7_blob.bin to write it to the address 0x0.
Click "Upload file to device..." and select the fip.bin to write it to the address 0x100000.

Click "Upload file to device... " and select the
IPCF_Example_multi_instance _S32G274_M7_0.bin to write it to the address 0x200000.

Click "Upload file to device... " and select the
IPCF_Example_multi_instance _S32G274_M7_1.bin to write it to the address 0x300000.

Enabling Multicore Application on S32G2 using S32G2 Platform Software Integration, Rev. 0, 11/2022
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13. Click "Upload file to device..." and select the

IPCF_Example_multi_instance_S32G274_M7_2.bin to write it to the address 0x400000.

Enabling Multicore Application on S32G2 using S32G2 Platform Software Integration, Rev. 0, 11/2022
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Run the application on S32G-VNP-RDB2

8 532 Flash Tool
File Help

Simple View
Initialization

Select target and algorithm for uploading:
Target

1 Override XOSC frequency
Algorithm MX25UW51245G v 40M

[ Secure serial bootloader:

% Prepare target for Ethernet upload...

% Upload target and algorithm to hardware...

Flash operations

T Upload file to device..

I Get flash ID..

I Download from device..

I Download from device to file..

® Erase memory range..

Execution

(@ Program finished successfully.

Browse...

- [m] X

Communication

Select communication device and
parameters:

® COM

Port name: COM4

O CAN Bus
Device name:
Port number.
Serial number:

O Ethernet

Host:

Configuring target
Progress: 180

Flash algo is loaded.
Device: Macronix MX25UW51245G

Capacity: 64 MiB (67188864 bytes)
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7.Run the application on S32G-VNP-RDB2

The following are the steps to run the application on the S32G2 RDB2 board.

1.
2.

N o g M~ ow

Insert the SD-Card to the slot on RDB2

Set RDB2 boot from external NOR-Flash

SW10-1=0ON,SW10-2=0FF

SW4 all OFF

Connect RDB2 UARTO to PC USB port

Launch a Serial terminal on PC, setup the serial port with baudrate 115200, format 8-n-1
Power on the RDB2. If everything is ok, you will get the A53 booting log on the terminal.

After Kernel is up, enter root to login.

Copy the IPC module files. The following commands needs to be entered in the terminal.

$mkdir ipc
$mount /dev/mmcblk0Op1l ./ipc
$cp fipclipc-shm-* ~

$umount ./ipc

Insert IPC modules

$insmod ipc-shm-dev.ko

$insmod ipc-shm-sample_multi-instance.ko

Run the IPC example. You will see logs showing IPC message between Linux Kernel and

Cortex-M7 cores.

NOTE

CORE4, CORES5, CORES® are the core ID for Cortex-M7_0, Cortex-M7_1

and Cortex-M7_2.

$echo 1 > /sys/kernel/ipc-shm-sample-instance0/ping
$echo 1 > /sys/kernel/ipc-shm-sample-instancel/ping
$echo 1 > /sys/kernel/ipc-shm-sample-instance2/ping

$dmesg | grep ipc-shm-sample_multi-instance

[ 462.703716] ipc-shm-sample_multi-instance:
[ 462.703739] ipc-shm-sample_multi-instance:
[ 462.703753] ipc-shm-sample_multi-instance:
[ 462.703797] ipc-shm-sample_multi-instance:
[ 462.703818] ipc-shm-sample_multi-instance:
[ 462.703850] ipc-shm-sample_multi-instance:

[ 470.935633] ipc-shm-sample_multi-instance:
[ 470.935653] ipc-shm-sample_multi-instance:
[ 470.935667] ipc-shm-sample_multi-instance:
[ 470.935712] ipc-shm-sample_multi-instance:
[ 470.935732] ipc-shm-sample_multi-instance:
[ 470.935763] ipc-shm-sample_multi-instance:

starting demo on instance 0...

INSTO ch 0 >> 19 bytes: SENDING MESSAGES: 1

INSTO ch 1 >> 32 bytes: #0 HELLO WORLD! from KERNEL
ch 0 << 19 bytes: REPLIED MESSAGES: 1

ch 1 << 32 bytes: #0 HELLO WORLD! from CORE 4

exit demo for instance 0

starting demo on instance 1...

INST1 ch 0 >> 19 bytes: SENDING MESSAGES: 1

INST1 ch 1 >> 32 bytes: #0 HELLO WORLD! from KERNEL
ch 0 << 19 bytes: REPLIED MESSAGES: 1

ch 1 << 32 bytes: #0 HELLO WORLD! from CORE 5

exit demo for instance 1
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[ 476.639610] ipc-shm-sample_multi-instance:
[ 476.639630] ipc-shm-sample_multi-instance:
[ 476.639644] ipc-shm-sample_multi-instance:
[ 476.639691] ipc-shm-sample_multi-instance:
[ 476.639709] ipc-shm-sample_multi-instance:
[ 476.639740] ipc-shm-sample_multi-instance:

Run the application on S32G-VNP-RDB2

starting demo on instance 2...

INST2 ch 0 >> 19 bytes: SENDING MESSAGES: 1

INST2 ch 1 >> 32 bytes: #0 HELLO WORLD! from KERNEL
ch 0 << 19 bytes: REPLIED MESSAGES: 1

ch 1 << 32 bytes: #0 HELLO WORLD! from CORE 6

exit demo for instance 2
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